Oracle® Retail Allocation User Interface Administration Guide, Release 13.3.0.1
E47939-01

Copyright © 2013, Oracle and/or its affiliates. All rights reserved.

Primary Author: Nathan Young

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Value-Added Reseller (VAR) Language

Oracle Retail VAR Applications

The following restrictions and provisions only apply to the programs referred to in this section and licensed to you. You acknowledge that the programs may contain third party software (VAR applications) licensed to Oracle. Depending upon your product and its version number, the VAR applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding any other term or condition of the agreement and this ordering document, you shall not cause or permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all alterations, translations, upgrades, enhancements, customizations or modifications of all or any portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-engineering or reverse engineering and recompilations or reverse compilations of the VAR Applications or any derivatives of the VAR Applications. You
acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or confidential information of the VAR Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to replace, with functional equivalent software, any of the VAR Applications in future releases of the applicable program.
Send Us Your Comments ........................................................................................................................ vii

Preface ........................................................................................................................................................ ix
  Audience ...................................................................................................................................................... ix
  Documentation Accessibility ......................................................................................................................... ix
  Related Documents ................................................................................................................................... ix
  Customer Support ....................................................................................................................................... ix
  Review Patch Documentation ...................................................................................................................... x
  Oracle Retail Documentation on the Oracle Technology Network ............................................................. x
  Conventions ................................................................................................................................................... x

1 Introduction to the WebCenter Portal Administration Console
  Accessing the WebCenter Portal Administration Console ............................................................................ 1-1

2 Configuring Page Templates and Skins
  Choose a Default Page Template ................................................................................................................ 2-1
    Select a Default Page Template for your Application .................................................................................. 2-1
  Choose a Default Skin ................................................................................................................................... 2-2
    Select a Default Skin ................................................................................................................................... 2-3

3 Modifying the Navigation Models
  Edit an Existing Navigation Resource ......................................................................................................... 3-1
  Restrict Access to URLs in the Navigation Model - Runtime ................................................................. 3-4
    Access Oracle Enterprise Manager Fusion Middleware Control ......................................................... 3-4
      Display the Security Menu in Fusion Middleware Control ...................................................................... 3-4
    Add Resource Permission ........................................................................................................................ 3-7
    Restrict Access to the URL link in the Navigation Model ....................................................................... 3-11

4 Creating Task Flows at Run Time
  Creating Task Flows at Run Time .............................................................................................................. 4-1
  Adding a Task Flow Link to a Navigation Model .......................................................................................... 4-8

5 Create and Deploy a Shared Library with Custom Task Flows
  Packaging Custom Task Flows into a Shared Library ................................................................................. 5-1
Configure Security .................................................................................................................................. 5-9
Referencing the Shared Library from Retail Allocation Portal.................................................. 5-10

6 Configure the Allocation Resource Catalog

Add Task Flows from a Shared Library ............................................................................................ 6-1
  Make the Resource Catalog Available to Users ............................................................................ 6-11
  Testing the Resource Catalog ........................................................................................................ 6-13
Send Us Your Comments

Oracle Retail Allocation User Interface Administration Guide, 13.3.0.1

Oracle welcomes customers’ comments and suggestions on the quality and usefulness of this document.

Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the Online Documentation available on the Oracle Technology Network Web site. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at http://www.oracle.com.
Preface

The Oracle Retail Allocation User Interface Administration Guide describes operations an administrator can perform to configure and manage the user interface and its security.

Audience

This document is intended for the retail client and system administrator of the online application.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

For more information, see the following documents in the Oracle Retail Allocation 13.3.0.1 documentation set:

- Oracle Retail Allocation Release Notes
- Oracle Retail Allocation Operations Guide
- Oracle Retail Allocation User Guide
- Oracle Retail Allocation Online Help

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL: https://support.oracle.com

When contacting Customer Support, please provide the following:
Product version and program/module name
Functional and technical description of the problem (include business impact)
Detailed step-by-step instructions to re-create
Exact error message received
Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for example, 13.3) or a later patch release (for example, 13.3.1). If you are installing the base release, additional patch, and bundled hot fix releases, read the documentation for all releases that have occurred since the base release before you begin installation. Documentation for patch and bundled hot fix releases can contain critical information related to the base release, as well as information about code changes since the base release.

Oracle Retail Documentation on the Oracle Technology Network
Documentation is packaged with each Oracle Retail product release. Oracle Retail product documentation is also available on the following Web site:

http://www.oracle.com/technology/documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These documents are packaged with released code, or you can obtain them through My Oracle Support.)

Documentation should be available on this Web site within a month after a product release.

Conventions
The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Introduction to the WebCenter Portal Administration Console

The WebCenter Portal Administration Console offers several administration pages that enable authenticated administrators to perform common administrative duties, including:

■ Configuring Page Templates and Skins
■ Modifying the Navigation Model(s)
■ Modifying the Resource Catalog
■ Creating Task Flows at Runtime
■ Managing Users and Granting Application Roles
■ Managing and Configuring External Applications

**Note:** For more information, please refer to the *Oracle Middleware Administrator’s Guide for Oracle WebCenter Portal*.

**Accessing the WebCenter Portal Administration Console**

Use the following procedure to access the administration console:

1. Log in to your application as an administrator.
2. Do one of the following:
   a. Click the Administrator link under the username.
   b. Access the WebCenter Portal Administration Console using the direct URL:
Accessing the WebCenter Portal Administration Console

http://www.server:port/context_root/admin
For example: http://mycompany.com:8888/myapp/admin
The WebCenter Portal Administration Console displays as shown:

Figure 1–2 The WebCenter Portal Administration Console
Applicable Oracle Retail applications are packaged with two page templates and three skins. Page templates are used to maintain a consistent branding and layout for all pages within an application as well as common branding and layout for all applications in a suite of applications. A skin is used to define the appearance of an Oracle ADF web application in a manner similar to CSS (cascading style sheets). Page templates and skins work together to control the layout and appearance of application pages. This section focuses on configuring a default page template and a default skin.

Choose a Default Page Template

In a WebCenter Portal application, page templates provide the basic structure and layout of application pages and work together with compatible skins to define how the application pages will look on the user’s screen. Every page displays within a page template. Administrators can define the default page template that is used. Applicable Oracle Retail applications provide the following two page templates:

- **RetailPageTemplate**
  This is the default page template used by applicable Oracle Retail applications.

  **Note:** If you are setting the default page template to RetailPageTemplate, then you must use either the Retail or RetailRed skin. See "Choose a Default Skin" on page 2-2 for additional information.

- **RetailUIShell**
  This is an alternative page template that has a more traditional Oracle Fusion look and feel. In Allocation, this means a page template (RetailUIShell) and skin (ApplcoreStyles) is provided to give the application a similar look and feel to the rest of the greater Oracle Fusion Application suite.

  **Note:** If you are setting the default page template to RetailUIShell, then you must use the ApplcoreStyles skin. See "Choose a Default Skin" on page 2-2 for additional information.

Select a Default Page Template for your Application

Use the following procedure to select a default page template for the application:

1. Click the Configuration tab of the Administration Console.
2. Choose a Default Page Template from the list provided.

**Note:** Sometimes the page template does not show up in the list even though it exists. If this occurs, open the EL Expression dialog and enter the path of the page template. You can open the EL Expression dialog from the Configuration tab of the Administration Console by clicking the down arrow next to each drop down field.

![Figure 2–1  Selecting a Default Page Template](image)

3. Click **Apply** to set the page template for your application.

**Choose a Default Skin**

Application administrators can customize the appearance of an Oracle Retail application by changing its skin. A skin changes the way the user interface appears, but does not change the application’s behavior. Applicable Oracle Retail applications provide the following three skins:

- Retail
  
  Retail is the default skin.

  **Note:** If you are setting the default skin to Retail, you must use the RetailPageTemplate page template.

- RetailRed
  
  RetailRed is similar to the Retail Skin. However the global header of the page template uses a red gradient rather than blue.

  **Note:** If you are setting the default skin to RetailRed, you must use the RetailPageTemplate page template.

- ApplcoreStyles
  
  ApplcoreStyles is a skin that provides a more traditional Fusion look and feel. Fusion look and feel means that your Allocation application will look similar to any other Oracle Fusion application.
Choose a Default Skin

Select a Default Skin

Use the following procedure to select a default skin for the application:

1. Click the Configuration tab of the Administration Console.
2. Choose a skin from the Default Skin list or enter the name of the skin in the Default Skin text box.

Note: If only one skin is enabled the Default Skin field will appear as a text box. If multiple skins are enabled the Default Skins field appears as a drop down.

Figure 2–2 Selecting a Skin

The skin you select is applied to all the pages in your application.

Note: The Default Skin has no effect on administration pages because the WebCenter Portal Administration Console uses an internal skin that does not change.

3. Click Apply to set the skin for your application.

Note: If you are setting the default skin to ApplcoreStyles, you must use the RetailUIShell page template.
The navigation model defines a navigational structure and keeps track of navigational data. A navigation model can consist of a variety of resources, such as task flows, pages, external links, and others.

It is important to note that the navigation model is aware of the security policies that have been applied to the elements (pages, links, task flows, and so on) that the navigation model controls. If the authenticated user is not authorized to see a particular page, the navigation model, by default, hides any navigational links to that page. For any resources that do not have security defined in the portal, such as external links, the user/admin has an option to control visibility manually by using the visibility field of the navigation item. One way to do this is to set the value of the "visible" attribute on a navigation item to an EL expression that evaluates to "false" or "true" to hide or show the resource.

**Edit an Existing Navigation Resource**

Use the following procedure to edit an existing navigation resource at runtime (in this example, we will add a link to an existing navigation resource):

1. Navigate to the Resources page in WebCenter Portal Administration Console.
   
   For additional information, see "Accessing the WebCenter Portal Administration Console" on page 1-1.

2. In the left navigation panel, select **Navigations** as the desired resource.

3. From the list of available navigations resources, select the resource you want to edit. (In the example below, the AllocationNavigationModel navigation model is selected.)

4. From the Edit menu, choose **Edit**.
5. In the Edit dialog, select the Add menu, choose **Link**.

6. In the Edit Navigation Item dialog, on the Target tab configure the following information:
   - The Link Name, as you want it to appear in the Navigation List
   - The URL location

   In the example below, Oracle is the Link Name and the URL Location is http://www.oracle.com.
7. On the Options tab, configure as appropriate.

**Note:** If the Open Link in the drop down list is set to popup, you must add the showCloseIcon attribute with a value of true in order for the close icon to appear in the popup window.

8. Click **OK**.

The Oracle link is now added to the AllocationNavigationModel navigation model.
9. Select **OK** to close the Edit dialog.

For setting security on added resources, continue with "Restrict Access to URLs in the Navigation Model - Runtime" on page 3-4.

**Restrict Access to URLs in the Navigation Model - Runtime**

Perform the following steps to restrict access to the newly added Oracle link:

- "Access Oracle Enterprise Manager Fusion Middleware Control" on page 3-4
- "Add Resource Permission" on page 3-7
- "Restrict Access to the URL link in the Navigation Model" on page 3-11

**Access Oracle Enterprise Manager Fusion Middleware Control**

Launch Fusion Middleware Control by entering its URL into a Web browser. The URL includes the name of the host and the administration port number assigned during the installation. This URL takes the following form: http://hostname:port_number/em. The default port is 7001. For more information about using Fusion Middleware Control, see *Oracle Fusion Middleware Administrator’s Guide*.

**Display the Security Menu in Fusion Middleware Control**

Use the following procedure to display the security menu in Fusion Middleware Control.

1. Log into Oracle Enterprise Manager Fusion Middleware Control by entering the URL in a Web browser.

   For example, http://hostname:7001/em.

   The Fusion Middleware Control login page displays.
2. Enter the Retail Fusion application's administrative user name and password and click **Login**.

   The password is the one supplied during the installation of the Retail Fusion application. If these values have been changed, then use the current administrative user name and password combination.

3. From the target navigation pane, open WebLogic Domain to display the application domain (for example: APPdomain). Display the Security menu by selecting one of the following methods:

   - Right-click the application domain and hover over Security in the popup menu to display a submenu.
From the content pane, select the application domain in the tree to open the domain’s home page. Open the WebLogic Domain menu located below the domain’s name and hover over Security to open the Security submenu.
Add Resource Permission

After having accessed the Oracle Enterprise Manager Fusion Middleware Control and opened the Security submenu, perform the following procedure to add a resource permission:

1. Select the Application Policies from the security sub menu to display the Application Policies screen.
2. Select the required Application stripe from the Application Stripe drop down (for example: ALC_PORTAL) and click the Search button to display the application policies.

3. Select the Privilege role from the Principal list which will have access to the URL (for example: ALC_ALLOCA_MAINTAIN_PRIV ), and select the edit icon to display the Edit Application Grant screen.
4. Use the **Add** button in the permissions section to add new Resource Permission and select Resource Permission from the drop down list of the Permission Class field.

5. Select **Continue** to add permission class details. Use the following values in the input fields and click the **Select** button.

   - Permission Class: `oracle.security.jps.ResourcePermission`
- Resource Name: resourceType=url,resourceName=OracleLink
- Permission Actions: View

**Figure 3–13  Adding Permission Class Details**

*Note:* Make sure that the Privilege role used to add resource permission is mapped to the job role intended to have access.

For example: ALC_ALLOC_MAINTAIN_PRIV is mapped to the ALLOCATOR_JOB role through ALC_ALLOC_MANAGEMENT_DUTY
Restrict Access to the URL link in the Navigation Model

Perform the following procedure to restrict access to the URL link in the navigation model:

1. Select the URL link from the navigation model and select Edit icon to display the Edit Navigation Item screen.

For example: Oracle link in the Navigation Model
2. Select the Expression builder option by clicking the drop down arrow next to the visible property.

3. Enter the following value in the Type a value or expression text field and keep clicking the OK button until you get to the Admin Portal page.
Restrict Access to URLs in the Navigation Model - Runtime

Modifying the Navigation Models 3-13

```javascript
#{securityContext.userGrantedResource['resourceType=url,resourceName=Oracle Link,action=view']} == true
```

**Note:** The values of resourceType, resourceName, and Action fields should match the values used in Add Resource Permission section.

---

**Figure 3–17   Entering a Value**

Access to the Oracle link should now be restricted to the ALLOCATOR_JOB role.

**Note:** You may need to wait few minutes (to refresh cache) for these changes to be reflected in your application.
Creating Task Flows at Run Time

Task flows are reusable building blocks developed using the Oracle Application Developer Framework (ADF). Rather than developing an application as a single large JSF page flow, application developers break up page design into a collection of reusable task flows. Oracle Retail Allocation was developed using task flows. The application's resource catalog is configured with additional task flows that can be added at run time. Using Oracle Composer, you can edit the application page from either the WebCenter Portal Administration Console or from the Edit Current Page menu item on the application's main page.

**Note:** Page edits made from the Administration Console are visible to all authorized users. Page edits made from the Edit Current Page menu item are visible only to the user who made the change.

The WebCenter Portal Administration Console allows authorized administrators to create reusable task flows at run time. These task flows are then included in the application's resource catalog, where they become available to authorized users for inclusion in the application.

Creating Task Flows at Run Time

The following example explains how to create task flows at run time in the WebCenter Portal Administration Console. It also explains how to modify the application's sidebar to add a link to the sample task flow.

1. Login to the Oracle WebCenter Administration Console as the admin user.
2. Select the Administrator menu item and open the Resources tab.
3. From the Mashups panel, select Task Flows.

5. Enter a name for the task flow and select a mashup style from the available choices.

6. Click **Create** to create the flow. Your new task flow shows up in the Mashups Task Flows panel.
7. From the Mashups Task Flows panel, select your new task flow from the list of task flows and select **Edit** from the Edit menu.

**Figure 4–5  The New Task Flow listed in the Mashups Panel**

Your empty task flow opens in an Oracle Composer window. From here you can edit your task flow to include the desired content. In the following example, the Web Content item in the resource catalog is used to add a web page to your new task flow.

**Figure 4–6  Editing the New Task Flow**
Figure 4–7  Empty Task Flow

8. Click the Add Content button, and then open the Web Development folder in the Add Content dialog by clicking the Open icon next to the folder.

Note: The following example shows just one of many components that can be added to your task flow. A more complex task flow can be created by nesting components within boxes and boxes within boxes to create a more complex layout.

Figure 4–8  Adding Content to the Task Flow

9. Locate the Web Page item and click the Add icon to add it to the task flow.
10. After adding the Web Page item, click **Close** to close the Add Content dialog.

11. To set the destination of the newly added web page:
   a. Click the Edit icon (wrench) in the toolbar of the Web Page header to open the Component Properties dialog.
b. Set the Source field in the Component Properties dialog to the URL of the web page.

Figure 4–11 Adding Properties to the new Work Flow

12. When you are finished making changes, save your changes and close the Edit Taskflow window. Composer will close and return back to the WebCenter Portal Administration Console.

13. If you are satisfied with your completed task flow, make it available for inclusion in your application’s resource catalog by opening the Edit menu and clicking Show for the newly created task flow.
Figure 4–12  Showing the New Task Flow

Adding a Task Flow Link to a Navigation Model

Now that you have created your task flow and made it visible, you have the choice of adding it to an existing page by using Oracle Composer to edit the page and add the task flow as content. You can also change your application's navigation model to add a link to the task flow in the application's sidebar. The following steps explain how to change the navigation model to add a link to your new task flow.

1. To add the task flow to the navigation model you need the task flow's URL. You need to gather some information about the task flow to create the URL:
   - The task flow URL
   - The task flow ID

2. Open a text editor and start with a blank page that you will use for a scratch pad. Enter the following text:

   taskflow:/

3. Back in your application’s WebCenter Portal Administration console, select the task flow and click on the About button.
4. Click on the "*" by the Metadata File name to view the full metadata file path/name.

5. Highlight the full text in the popup window then copy it to the system clipboard (control-C for example).
6. Paste the metadata file name from the clipboard to your text editor, appending it immediately following the existing text. At the end of this string add the single character "#". The resulting string will look something like this (all on one line):

```
taskflow://oracle/webcenter/siteresources/scopedMD/a8bba98ff_4cbb_40b8_beee_296c916a23ed/taskFlow/gsrfl7a1350_c41c_4294_b5b8_6349b2cc353d/taskflow-definition.xml#
```

7. To complete the URL you need the taskflow ID. In the Administration Console, open the Edit menu and click **Edit Source**.

**Figure 4–15  Selecting Edit Source**

8. Locate the "id" attribute in the Edit Source dialog and highlight its value.
9. Copy and paste the ID to your temporary text file to complete the task flow URL. The result will look similar to the following string.

```
<taskflow://oracle/webcenter/siteresources/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/taskFlow/gsrf17a1350_c41c_4294_b5b8_634b2cc353d/taskflow-definition.xml#blanktaskflow
```

**Note:** The above string is an example. Your URL will vary but the format will be similar.

10. Now you are ready to add a link to this task flow in your application’s navigation model. Select **Navigations** in the Structure list of the Resources tab of the Administration Console.
11. Select the AllocationNavigationModel navigation model and open the Edit menu. From the Edit menu, select Edit.

**Figure 4–18  Selecting your Task Flow to Edit**

12. Click the Add button and select Link.
13. In the Edit Navigation Item dialog, change the Name field to the value you want to display in the application's navigation tree. To internationalize the string, click on the downward pointing icon to the right of the Name field.

14. Change the Path field to specify the URL of the task flow. The task flow URL is a concatenation of "taskflow://" followed by the metadata file path name followed by "#" followed by the task flow id. In the example above, the task flow URL to paste in the Path field of the Edit Navigation Item - Link dialog is:

```
taskflow://oracle/webcenter/siteresources/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/taskFlow/gsrfl7a1350_c41c_4294_b5b8_634b2cc353d/taskflow-definition.xml#blanktaskflow
```

15. If you are done making changes, click OK to save changes. The task flow should now be added to your navigation model and should be visible in the application's navigation tree. If you want to control the visibility of the task flow, proceed to the next step.

16. To control access to the task flow, in the navigation model, select the Expression Builder option next to the Visible field.
17. Using the expression editor, specify the groups and application roles that are allowed to access the task flow in the navigation model as shown in the example below.

**Figure 4–22  Specifying the Group and Application Roles**

18. The example above used EL expression -

`#{WCSecurityContext.userInGroup['BUYER_JOB'] or WCSecurityContext.userInAppRole['Administrator']}'

This expression will limit access to the task flow to the users who have BUYER_JOB role or users in 'Administrator' application role. Use the 'or' clause to add more roles to have access to the task flow.
Create and Deploy a Shared Library with Custom Task Flows

This chapter contains instructions on how clients can create and deploy their own shared library with their custom task flows, as well as how they can reference their shared library from Allocation. Once clients have followed the procedures in this chapter, they will be able to configure their resource catalog. See Configure the Allocation Resource Catalog for additional information.

Packaging Custom Task Flows into a Shared Library

Use the following procedure to package custom task flows into a shared library.

1. Develop custom task flows that will be used to extend the functionality within Retail Allocation.

   Examples of these task flows are those that render custom reports or business intelligence panels that can be placed in dashboards or contextual panes within Retail Allocation using WebCenter’s Runtime Customization facilities. These task flows should be tested and functional before proceeding with the rest of the steps. Refer to the Fusion Developer’s Guide for Oracle Application Development for details (http://docs.oracle.com/cd/E23943_01/web.1111/b31974/taskflows.htm).

2. Package the custom task flows into one or more ADF Library JAR files.

   Refer to section 33.2 of the Fusion Developer’s Guide for Oracle Application Development Framework (http://docs.oracle.com/cd/E23943_01/web.1111/b31974/reusing_components.htm#BEIGHHCG). Generate the ADF Library JAR file(s) and make note of the following:

   - The path and name of the generated JAR files.
   - The path and name of other JAR files your custom task flows depend on during runtime.
   - The fully-qualified, runtime-referenceable path to the custom task flows within the JARs.

     Example:
     /WEB-INF/mycustomflows/CustomItemFlow.xml#CustomItemFlow.
   - New security roles and permissions being referenced by the task flows and their underlying elements.
   - Server resources such as data sources or JMS queues that the custom task flows need.
3. Create a new Fusion Web Application JDeveloper workspace to be used as a shared library deployment containing your custom task flows.
   a. Open JDeveloper and create a new Fusion Web Application Workspace.

   Figure 5–1 New Workspace Window

   ![New Workspace Window](image)

   b. Provide a name and Java package for the new workspace and click Finish to generate the JDeveloper workspace.

   Figure 5–2 Name Your Application Window

   ![Name Your Application Window](image)

   The workspace should have a project structure similar to the following:
4. Add the custom ADF Library JAR files into the Web or ViewController project.
   a. Right-click on the web / view-controller project and choose Project Properties
   b. The Project Properties dialog appears. Select the Libraries and Classpath section and add your custom ADF Library JAR files as well as dependency JARs using the Add JAR/Directory button.
5. Add a Manifest file containing the name of the shared library.
   - In the web/view-controller project’s src directory, create a new file called MANIFEST.MF with the following contents:
     
     ```
     Manifest-Version: 1.0
     Ant-Version: Apache Ant 1.7.0
     Implementation-Title: <Name of the library>
     Created-By: 10.0-b23 (Sun Microsystems Inc.)
     Extension-Name: <library.name>
     ```
     
     Specify meaningful and unique values for the implementation title and extension name. Example:
     
     ```
     Manifest-Version: 1.0
     Ant-Version: Apache Ant 1.7.0
     Implementation-Title: Acme Retail Allocations Custom Flows
     Created-By: 10.0-b23 (Sun Microsystems Inc.)
     Extension-Name: company.alc.custom
     ```

6. Create a deployment profile for the shared library.
   a. Right-click on the web/view-controller project’s Project Properties.
b. Navigate to the Deployment section of the Project Properties dialog. Clear all pre-generated deployment profiles in the Deployment Profiles list.

c. Create a new Deployment Profile. Choose WAR File for the Archive Type and provide a meaningful name for the profile (this name will be used as the file name of the WAR file). Click OK when done to proceed to the Edit WAR Deployment Profile Properties.
In the Edit WAR Deployment Profile Properties, go to the General section and select Specify Java EE Web Context Root but leave it EMPTY.

A warning will be shown when you navigate to other sections of the dialog because the context root is blank. This is intentional and this warning can be ignored. Click Yes on the dialog.
e. Go to the WAR Options section of the Edit WAR Deployment Profile Properties dialog. Select Include Manifest File… and Add the custom manifest file created in the earlier step.

f. Click OK to close the Edit WAR Deployment Profile Properties dialog.

7. To create the shared library WAR, right-click on the web/view-controller project, choose Deploy on the newly created deployment profile.
8. From the Deployment Action dialog, select Deploy to WAR and click Finish.

When your newly created deployment profile is deployed, a message similar to the following is displayed.

![Figure 5–14  Deployment Progress](image-url)
9. Create the server resources needed by the custom task flows. If the custom task flows require new server resources such as data sources and JMS queues, make sure that those are created and operational in the same managed server as the Retail Allocation Portal application. This task has to be done using the WebLogic Administration Console with a user having WebLogic administration permissions.

10. Deploy the generated WAR file to the same managed server as the Retail Allocation Portal application as a shared library. Refer to section 6 of the Deploying Applications to Oracle WebLogic Server documentation (http://docs.oracle.com/cd/E23943_01/web.1111/e13702/deploy.htm). This task has to be done using the WebLogic Administration Console or Enterprise Manager Fusion Middleware Control with a user having WebLogic administration permissions.

**Configure Security**

Once the shared library containing custom task flows has been deployed to the managed server, you must add any new application roles and policies being referenced by the custom task flows into the Retail Allocation’s policy store.

Use the Oracle Enterprise Manager Fusion Middleware Control console to add application roles and policies. This task has to be done with a user having WebLogic administration permissions.


You will need to specify ALC_PORTAL as application stripe.
Referencing the Shared Library from Retail Allocation Portal

At this point, your custom task flows have to be packaged in a shared library, deployed in the same managed server as Retail Allocation, and new application roles and policies have to be registered in the managed server's policy store.

Retail Allocation is installed with a shared library called the Allocation Portal Extensions. The purpose of this shared library is to have references to other custom shared libraries that contain content customers develop themselves.

The Allocation Portal Extensions share library minimizes the need to modify the deployed files for Retail Allocation Portal, thereby minimizing the risk of corrupting the application itself.

Figure 5–16  Diagram: WebLogic Managed Server

To make your task flows accessible from the Retail Allocation Portal application, the Allocation Portal Extensions should be changed to reference the custom ADF Task Flow shared library.
To do this:

1. Log into the WebLogic Administration Console as a user with administrative permissions.

2. If the administration console was configured with domain configuration locking, go ahead and click on the Lock & Edit button to ensure that other administrators can be prevented from making changes during your edit session.

3. Navigate to the Deployments section.
4. Shut down the Retail Allocation Portal Application. Under the deployments list, select the Enterprise Application named EarAlcCommonPortal and click on Stop/Force Stop Now. Wait for the shutdown process to complete.

5. Get the deployment location of the Allocation Portal Extensions shared library. Under the deployments list, click on the link for the library named oracle.retail.apps.alc.portal.extensions. The Settings page for the library appears.

Figure 5–20 Settings for Library Window
The Settings page will show the file location of the WAR file (WarAllocPortalExtensionsSharedLibrary.war) for the Allocation Portal Extensions shared library under the Path entry. Make note of this file location.

6. Using the operating system's file manager application, go to the location of the WAR file. You will need read and write permissions to the file system where the WAR file is located.

7. Make a copy of the WAR file as back-up.

8. Open the original WAR file using an archive file manager and update the /WEB-INF/weblogic.xml by adding a new <library-ref> entry pointing to your custom task flows shared library.

   <library-ref>
   <library-name>company.aic.custom</library-name>
   </library-ref>

Once this change is done, you have now linked your custom task flows shared library to the Retail Allocation Portal.

9. Return to the WebLogic Administration Console. Go to Environments' Servers section. Under the Control tab, select the managed server where Retail Allocation is deployed to. Shut it down and start it back up again.

Figure 5–21 Summary of Servers Window
Configure the Allocation Resource Catalog

This chapter describes how to configure the Allocation resource catalog to include task flows from a shared library. Prior to configuring the Allocation resource catalog, the tasks in the Create and Deploy a Shared Library with Custom Task Flows chapter must be performed.

The example in this chapter uses a HelloWorld task flow that was created for testing purposes only. This task flow is not available out of the box with the Allocation application.

Add Task Flows from a Shared Library

The following steps show how to add task flows from a shared library to an application’s resource catalog at run time.

1. Log into the application as a user with administrative privileges.
2. Click the Administrator menu item to navigate to the WebCenter Portal Administration Console and open the Resources tab.

![WebCenter Portal Administration Console](image)

4. We want to add task flows to the existing resource catalog. However, the administration console will not allow you to edit the default resource catalog, so the first step is to make a copy of the default catalog. Select the default catalog, open the Edit menu, and click **Copy**.

5. Enter a name for your new resource catalog then click **OK** to copy the catalog.
Add Task Flows from a Shared Library

**Configure the Allocation Resource Catalog**

6-3

Figure 6–4  Naming the Resource Catalog

The copied resource catalog should now appear in the list of resource catalogs.

**Note:** When modifying any resource catalog, it is a good practice to make a copy of the resource catalog and edit the copy. After you have made your changes you can use the Administration Console Configuration tab to set your new resource catalog as the application’s default resource catalog.

The copied resource catalog should now appear in the list of resource catalogs.

**Figure 6–5  The Copied Resource Catalog in the Resource Catalog List**

6. Select the new resource catalog and open the Edit menu.
7. Click **Edit** to open the Edit dialog.

**Figure 6–7  The Edit – New Default Resource Catalog Dialog**

8. The items in the resource catalog are organized into folders. To add a new folder to the catalog, click the **Add** button and select **Folder**.
9. In the Edit Resource Catalog Item dialog, enter a name for the new folder. Folder names can be entered as text or can be entered as a text resource. Click on the icon to the right of the Name field and click Select Text Resource.

10. In the Select Text Resource dialog you can search for existing text resources or create new ones. We will create a new text resource. Click the Create button to add a new row to the table.
11. In the display value column, enter the folder’s display name (for example Custom Task Flows). In the Key value, enter a key for your string (for example custom_task_flows). Click the Refresh icon. The administration console will generate a full key with some additional context at the beginning of your key.

12. Click Use (last column of the table) to select the newly created text resource. Note the changes to the Key and Display Value fields. In addition, note that the value of the last column changes from Use to Active.
13. Click OK to select the new text resource.
14. Click OK in the Edit Resource Catalog Item dialog to save the changes to the folder, add it to the resource catalog, and return to the Edit dialog. The new folder should now be in the top-level list of resources.

*Figure 6–14  The Edit – New Default Resource Catalog Dialog*

15. Open the Preview tab to get a preview of what the new folder will look like.

*Figure 6–15  The Edit – New Default Resource Catalog Dialog Preview Tab*

16. Select the new Custom Task Flows folder in the Design tab. Click the Add button and select Add From Library.
17. The Add Resource Catalog Item dialog opens. In the left pane is a list of resources that can be added to the catalog. Click Task Flows to add a task flow. The list of task flows that are available to the application appears in the right pane of the dialog.

18. For this simple example we will add the HelloWorld task flow to the resource catalog. Scroll the list of task flows until the task flow is visible. Select the HelloWorld task flow.
19. Click **Add** to add the task flow to the Custom Task Flows folder.

20. Open the Preview tab to preview the HelloWorld task flow in the Custom Task Flows folder.
Figure 6–20 Previewing the Task Flow

21. Click **OK** to save the changes to the resource catalog.

**Make the Resource Catalog Available to Users**

Once you have modified your new resource catalog you need to make it available to other users.

1. In the administration console, select the new resource catalog, open the Edit menu and click **Show**.

**Figure 6–21 The Resource Catalogs Edit Menu**

**Note:** If the new task flow does not appear in the Custom Task Flows folder, this usually indicates that view permissions have not yet been granted for the task flow. See "Restrict Access to URLs in the Navigation Model - Runtime" on page 3-4 for additional information.
The new resource catalog should now be available.

**Figure 6–22  The Available Resource Catalog**

2. Open the Configuration tab.

**Figure 6–23  WebCenter Portal Configuration Tab**

3. Click on the Default Resource Catalog field to open the list of available resource catalogs.
4. Select the new resource catalog from the list.

5. Click Back to Portal to return to the application.

**Testing the Resource Catalog**

Use the following procedure to test the resource catalog:

1. Log in as a user with administrative privileges who also has permission to view the HelloWorld task flow.

2. If you are no longer in the WebCenter Portal Administration Console, click the Administrator menu item to return to the Administration Console. Open the Resources tab. Select Pages in the Structure pane.
3. Select the application’s main page in the All Pages list.

4. Click on the Actions icon to open the Actions popup menu. Select the Edit Page menu item to open the page in Oracle Composer. Click the link in the application sidebar to open the content you would like to edit. In this example we will be editing the Allocator Dashboard.

5. In the Oracle Composer window you will see one or more buttons for adding content. Click Add Content to open the Add Content dialog. The contents in your Add Content dialog may differ from this example, depending on the items in your application’s resource catalog.
Figure 6–28  The Allocator Dashboard

6. In the Add Content dialog, click the **Open** icon to the right of the Custom Task Flows folder to open the folder.

Figure 6–29  The Add Content Dialog

7. Click the **Add** icon to the right of the HelloWorld task flow to add the task flow to the page, then click **Close** to close the dialog. The HelloWorld task flow has been added to the page.

**Note:** If the Custom Task Flows folder is empty, it probably indicates that the user does not have permission to view the task flow(s) in the folder.
8. At this point you may want to change some of the task flows properties. Click the Edit (wrench) icon at the right end of the HelloWorld task flow header.

9. Enter a new title for the task flow in the Text field. In the following example we have changed the title to “Sample Task Flow”.

Figure 6–30  The Custom Task Flows List

Figure 6–31  Adding the HelloWorld Dashboard
10. Click **OK** to change the title and return to the main Composer window:

11. Click **Save** to save the changes.

**Figure 6–33  The Main Composer Window**

12. Click **Close** to end the edit session.

   The HelloWorld task flow has now been added.